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Airport Design Basics 
“If  you build it, they will come.” 

hree fundamental design elements of any airport in Flight Simulator X (FSX) 
are Paths (also called Links), Parking, and Aprons. Paths or links connect the 
various elements of the airport together. For example after an aircraft lands on 
the runway, it exits the runway via paths to its assigned parking spot. In FSX, 

parking is classified generally as either general aviation ramp parking or gate parking.  
As the term implies, parking provides a place for your user aircraft and AI aircraft to go 
once they land at your airport. If you do not provide paths, aircraft won’t be able to 
move around your airport.  If you do not provide proper parking, ATC and AI traffic 
will not function properly at your airport. 

Aprons, on the other hand, are like the blank canvases used by artists to paint their 
masterpieces. They don’t “connect” to any thing per se, but they do provide the 
background for almost everything you do at your airport. 

This tutorial will provide step-by-step instructions on how to create and to modify 
paths, parking, and aprons at a stock airport. To follow along, you will first need to 
install Airport Design Editor Home Edition (ADE) by following the steps outlined in 
the Installation & Configuration Tutorial.  You should also have read through the 
ADE manual and be familiar with the various functions within ADE. You can 
download ADE and its manual as well as the tutorial from The ScruffyDuck Software 
Company or from fsdeveloper.com. 

 

 

 

Special thanks to Jon Masterson and to the members of the Airport Design Editor 

Development Team on fsdeveloper.com for their direction, guidance, and expertise, without 

which, this tutorial would not be possible.

Tutorial 
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Begin with the End in Mind 
Before you start modifying airport elements and redesigning your first airport, you 
need to establish an idea of what you want to accomplish. For this tutorial, you are 
going to make several simple changes to KMGY, or the Dayton-Wright Brothers 
Airport, located in Dayton, Ohio. Dayton is known as the birthplace of aviation, so it is 
appropriate that your first airport design project begin there. 

 
Figure 1 - Sectional View of Dayton-Wright Brothers (KMGY) 

Once you select the airport, you need to determine what you want to add and/or 
modify about the stock FSX airport. The good news is that most FSX stock airports 
leave a lot of room for improvement, so your options are numerous. In the case of 
KMGY, you will make several changes to airport parking, taxiways, and aprons. 

To begin making your changes to KMGY, you 
need to first open the stock airport in ADE.  To 
open a stock airport, select Open Stock Airport 
under the File menu. 

 

 

 

Next, choose a stock airport with which to work using the Airport List Screen. For 
this tutorial, select KMGY by choosing the International Civil Aviation Organization 
(ICAO) code list button, typing “KMGY” in the field below the list buttons, and either 
clicking the “Find Now” button to the right or pressing Enter. ADE will then provide 
the results of your search as “KMGY – Dayton-Wright Brothers.” 
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Figure 2 - ADE Airport List Selection Screen 

Double click on the results, and ADE will load the stock KMGY airport. 

According to the airport operational 
statistics, The Dayton-Wright Brothers 
Airport is home to over 80 aircraft, 
mostly single engine airplanes. After ADE 
opens the stock KMGY, you will see that 
there are only eleven parking ramps and 
one fuel ramp. By mousing over each 
parking ramp, you will notice the parking 
ramps are divided into five small ramps, 
four medium ramps, and two large ramps. 
In the future, you can quickly view/edit 
parking ramp/gate information at an 
airport by selecting Parking under the List 
Menu. 

 

 

Figure 3 – Stock KMGY Airport in ADE
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First Things First 
After you have loaded KMGY in ADE, you next need a template from which to work 
and to make your changes. Most experienced airport designers use maps, Jeppesen 
charts, photos, and/or satellite imagery to determine what airport elements they want 
to add, modify, or remove. For this tutorial, you will use Virtual Earth by going to the 
following URL: 

http://maps.live.com/default.aspx?cp=39.588972|-
84.224861&style=h&lvl=14&v=1. 

 
Figure 4 – A view of KMGY via Virtual Earth 

A Word of Caution: The airports in FSX are generally current as of 2006. 
While satellite imagery is readily accessible via Google Earth, Virtual Earth, 
TerraServer, etc. these images may be several years older than the information 
in FSX and be out of date.  Therefore, make sure you have the most recent 
information available before making changes to stock airports. 
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After you’ve pulled up KMGY using Virtual Earth, zoom in to the Fixed Base 
Operator (FBO) area in the Northwest part of the airport.  You should see something 
like this: 

 
Figure 5 - KMGY FBO and Parking area (Virtual Earth) 

Now, compare that to the same location on the stock airport in ADE. 

 
Figure 6 - KMGY FBO and Parking area (stock FSX airport) 

As you can see, the FBO area in the stock FSX airport leaves a lot to be desired. Even 
notice that where parking exists at the real airport, the stock airport just includes a taxi 
path that is not even functional!  You are going to change that, and this tutorial will 
show you how. 
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But, before you start adding parking ramps like crazy and moving/deleting taxi paths, 
you should first view the stock airport in FSX with the Scenery slider set to Ultra 
High. This allows you to see what other scenery or autogen objects may impact what 
you want to do. Although modifying airport elements in ADE is straightforward, 
sometimes getting them to work with the existing airport scenery can be a challenge.  
There are programs which you can use to delete, modify, or add airport scenery and 
landclass, but that goes beyond the scope of this tutorial. 

 

 
Figure 7 - FSX Settings Screen 
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After you load FSX, max out your Scenery slider, and select KMGY in free flight, you 
should see something similar to the picture here: 

 
Figure 8 – Stock KMGY Airport FBO in FSX 

With the Scenery slider maxed, you can see the airport buildings and beacon next to 
the FBO apron, and you will notice that useless taxi path to the right of the apron. 
Again, you are going to change that.  And, now that you have taken a look around the 
airport, it is time to get started. 



A I R P O R T  D E S I G N  E D I T O R  H O M E  E D I T I O N  

8 

Adding & Modifying Airport Parking 
Look again at the stock KMGY FBO apron in ADE. There are six existing parking 
ramps here that you can modify to add additional parking and to make the FBO apron 
look more like the real thing. 

 
Figure 9 - KMGY FBO and Parking area (stock FSX airport) 

 

To align all of your new and modified airport elements, the first thing you 
need to do is create two Guidelines. 

Guidelines are ruler lines that can be laid-down anywhere on the ADE screen. This can 
be useful, for example, when trying to place several objects in a straight line. Guidelines 
are proper ADE objects and as such can be added, deleted, moved, rotated, and edited. 
Undo/Redo also works with them. Guidelines are kept in the .ade file but are not 
compiled into the .bgl file. 

A crossbar marks the guideline’s origin, while a small arrowhead indicates the terminal 
end of the guideline. The tool tip shows length (in user defined units) and the heading 
taken from the origin to the end. 
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The guidelines you create for KMGY should 
be long enough to span across the FBO 
apron, and one should be parallel to and the 
other perpendicular to the existing taxi path. 
Use the taxi path as a reference, and draw the 
guideline down the center of the path.  This 
will create a parallel (or vertical) guideline, 
which should have a heading of 183.9 
degrees. Now you can create a perpendicular 
(or horizontal) guideline by drawing another 
and setting it to 273.9 degrees (or 183.9 + 
90). Using these two guidelines, you can now 
align parking ramps, taxi links, and any new 
aprons you need to create for this tutorial. 

Figure 10 - KMGY FBO Apron with Guidelines 

 

To make changes quickly and easily to a 
guideline, you can either double-click it to bring 
up the property box, or you can select it and use 
the rotate handle to quickly change the heading.   

Like most objects, you can move a guideline by 
‘grabbing’ it with the mouse and dragging it. You 
must be in Pointer Mode to do this – select the 
normal Pointer from the toolbar. 

You can delete a guideline by selecting it and 
pressing the Delete key or right click and delete. 

You can also Hide or Show guidelines from the 
View Menu. 

 

Figure 11 – ADE Guideline Properties Box 

The next thing you need to do is change the size of the existing FBO apron parking 
ramps.   

To do this, select the first ramp, and while holding down the SHIFT key, select the 
other ramps as well. After you have selected all the ramps, press Enter. This will bring 
up the Multi-Select Properties Box, where you will make your changes. 
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In the Type field, select RAMP_GA_LARGE. 
In the Radius field, enter 11.00 (in meters, or 
36.09 feet). Enter 4.00 in the T1 field under Tee 
Offsets. And finally, enter 273.9 in the Heading 
field. Click the OK button when finished. 

 

 

 

 

 

 

Figure 12 - ADE Multiple Selection Property Box 

Your FBO apron should now look like this: 

You may be asking, “Why should I 
adjust the size of the parking ramps 
and the tee offsets?” General 
aviation (GA) parking ramps come 
in three sizes: small, medium, and 
large. Which size you choose is 
based on your airport and the 
wingspan of the aircraft that 
frequent your airport. 

Nothing larger than a corporate jet 
or a turbo prop operates out of 
KMGY. Consequently, GA parking 
ramps with a radius larger than 11 
meters are overkill and waste 
valuable real estate on the apron. 

 

Figure 13 - KMGY Apron with Large Parking Ramps 

Tee offsets, on the other hand, are used mainly for aesthetic reasons because regardless 
of where you position them, they do not impact aircraft behavior. 
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By default, a "T" is placed at the end of the parking link and positioned at the center of 
the parking ramp / gate. Tee offsets allow the designer the ability to bring the "T" 
forward so it becomes more visual. There are four "T" values that you can add, but in 
the real world there can be more than that. 

 
Figure 14 - Example of real world parking T's 

When an aircraft pulls up to a jetway in the real world, the ground crewman looks to 
see what type of aircraft is entering the parking spot and then based on a "T," the 
ground crew knows where to stop the nose wheel. This makes sure the plane parks in 
the correct position, and if a jetway exists, it will align properly to the doors when 
moved into position by the operator. 

 
Figure 15 - Example of aircraft tee positioning based on type 

Parking tees are not limited to jetway type parking spots, but are also found on general 
aviation parking ramps for all types of aircraft.  The best practice with using tee offsets 
in FSX is to set them based on the type of aircraft you anticipate will park at the 
parking gate and/or ramp. As a word of caution, sometimes FSX does not properly 
display parking tees when the parking spot heading is the same as the connecting 
parking link. If you encounter this problem, try moving the parking spot a small 
amount in any direction or adding a node to the parking link outside of parking circle.  
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Experienced airport designers use generally accepted parking and tee dimensions at 
their airports. The best practice is to use the following dimensions for general aviation 
parking ramps instead of the FSX defaults: 

Ramp Size Aircraft Radius 
(in Meters) 

Radius 
(in Feet) Tee Offset 

Small 
Small single 
prop planes 
(e.g. C-172) 

5.0 16.40 1.22 

Medium 
Small twin prop 

planes 
(e.g. Baron) 

7.0 22.97 2.13 

Large1 
Turbo props 
(e.g. King Air 
and Learjet) 

11.0 36.09 4.00 

Large2 
Very large GA 
(e.g. DC3 and 
large corp jets) 

15.1 49.54 5.00 

 

If you want more precise parking dimensions by aircraft, Reggie Fields has compiled 
aircraft specific parking radii and ramp/gate size recommendations that are used 
throughout the MSFS developer community. You can find more information by going 
to the links below: 

http://www.flightsim2004-fanatics.com/FlightSim/FSX_AI_Parking_FAQ.pdf 

http://www.flightsim2004-fanatics.com/FlightSim/FSX_Parking_Matrix_Type.pdf 

http://www.flightsim2004-
fanatics.com/FlightSim/FSX_Parking_Matrix_MyTraffic.pdf 

http://www.flightsim2004-fanatics.com/FlightSim/FSXWingSpanValues.htm 

To change the default radii in ADE to match these recommended values, refer to page 
11 of the Installation & Configuration Tutorial. 

 

After adjusting the size of the parking ramps, you next need to create an 
Apron Link (or Path) down the center of the FBO apron (using your vertical 
guideline) that connects to all the parking links. This will allow you to add and 

align additional parking ramps to the apron. 

To add the links, select the Apron Link function on the toolbar and position the 
crosshair over the top taxipath until it is highlighted and the taxipath tool tip appears. 
While holding down your left mouse button, drag the crosshair down to the next 
taxipath until that path is highlighted.  Release your mouse button, and ADE will 
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create a new taxipath between the two existing taxipaths. You will notice that ADE 
automatically adds two new blue Normal Taxi Points (or nodes) when you connect the 
new taxipath to the existing paths. 

Now, create additional links down the center 
of the FBO apron by starting each link at the 
node created by the previous link. 

 

 

Figure 16 - New Taxipath with Blue Normal Taxi Points 

Be sure that your new apron links connect to 
each existing link with a blue node. You can 
verify that it is connected by hovering over 
the taxi point. When you place your pointer 
over a node, any link connected to it will be 
highlighted. If you create a link that does not 
connect properly, either click the Undo 
button or delete it and try again. Usually the 
existing link will display a tool tip when you 
mouse over it to indicate you can connect to 
it. 

Before going further, you should lock the 
FBO apron by selecting it and choosing Lock 
Object from the right-click menu. Locking 
the apron will keep you from moving it by 
mistake when you are positioning and aligning 
objects on the apron later. 

Figure 17 - KMGY FBO Apron with new apron links 

 

You will also now want to create another vertical guide 
(183.9 degree heading) to help you space your parking 
ramps. In this case, the distance you should use is 22 
meters (72.18 feet).  
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Next, add four new large GA Parking Ramps between 
the existing ramps. 

 

After creating the new ramps, multi-select 
them as explained previously and change their 
properties to match the existing ramps.  Now, 
move your newly created spacing guideline as 
well as your longer vertical guideline to the first 
ramp to begin positioning the parking ramps. 

You will use the bottom parking ramp as a 
reference point to align your other parking 
ramps. Space your first and second parking 
ramps using your 22 meter spacing guideline, 
then align the second to the first using the 
longer vertical guideline. 

 

 

Figure 18 - KMGY FBO Apron with new Parking Ramps &  Spacing Guideline 

 

Now you can use the spacer guideline to 
position your third and subsequent parking 
ramps. Don’t worry about aligning the parking 
links just yet. 

When you space ramps or gates close together, 
sometimes it will cause an issue with AI 
aircraft. If parking spots are too close, AI 
aircraft can sometimes appear to turn into each 
other as they push back.  This issue is more 
prevalent when using smaller radius parking 
because the push back distance is shorter. 

 

Figure 19 - Using Guidelines to Align Parking Ramps 
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When you get all the parking ramps aligned, your FBO apron should look like this. 

The next step is to connect your newly aligned 
parking ramps to the apron links you created 
earlier. To create new Parking Links, first 
position your horizontal guideline (273.9 degree 
heading) on the center of your new parking 
ramp, select the apron link button on the tool 
bar, and draw a parking link from anywhere in 
the ramp area to the center apron link you 
created earlier. As a word of caution, if the ramp 
is highlighted when you try to attach the parking 
link, it will not connect properly.  

 
Figure 20 - KMGY FBO Apron with Parking Ramps aligned and spaced properly 

Be sure all the parking links are properly 
connected to both the parking ramp and the 
center apron link. After creating new parking 
links, you now need to realign the existing parking 
links. To align existing parking links, use both the 
vertical and horizontal guidelines by positioning 
the vertical guideline on the center apron links and 
the horizontal guideline on the center of the 
parking ramp.  Now you can move the existing 
blue normal taxi points into the correct position 
by selecting them with your pointer and dragging 
them. 

 
 

For the last existing parking link, you will need to 
add a normal blue taxi point (or node) to the 
center of the link by using the Add Normal Taxi 
Point tool bar icon. (As a general rule, nodes 
should only be added to existing taxi links.) Once 
you add the node, position it up and over using 
both guidelines. 
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Once you have aligned the parking links, you should delete the unneeded links to the 
right. When deleting these existing apron links, start at the bottom right and work up. 
You will keep the first and the last apron links, but delete the ones in the middle.  

To delete an apron link, just select the 
link and press your delete key. If you 
accidentally delete the wrong link, click 
the Undo button. When you have 
completed adding, positioning, and 
deleting the parking links, your 
KMGY FBO Apron should look 
similar to this. 

 

 

 

 

 

 

 

Figure 21 - KMGY FBO Apron with aligned parking links 

Next, we want to add additional parking on the East side of the FBO apron. To do 
this, add six more large GA parking ramps to the right of your center apron links. 
Once again, multi-select these new parking ramps, and change their properties to 
match the others, except this time use a heading of 93.90 degrees (273.9 - 180). Use 
your vertical guideline to align the bottom parking ramp close to the main taxi path and 
make sure it is aligned between second and third parking ramps on the West side of 
the FBO apron. 

 

Using the same techniques described 
earlier, begin spacing and aligning 
these new parking ramps using the 
spacer and vertical guidelines, and 
connect them to the center apron 
links using the horizontal guideline. 
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After completing these steps, your FBO apron should look like this: 

 
Figure 22 - Completed KMGY FBO Apron 

To finish off the changes you have made 
to the KMGY FBO apron, you should 
multi-select all the apron and parking 
links, and make sure their width is set to 
22 meters (72.18 feet) and the Center 
Line box is selected.  This will ensure 
every thing looks uniform on the apron 
when you view it in FSX. 

 

 

 

 

 

 

Figure 23 - Apron Link Multi-Select Properties 
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Before you forget, go ahead and save your work by going to the File Menu and 
selecting Save Airport. This will create an ADE file that includes the guidelines you 
created so that you can use them again the next time you load this airport in ADE. 

If you want to review your handiwork thus 
far in FSX, you should run the ADE Fault 
Finder under the Tools Menu. The Fault 
Finder will catch airport design errors and 
allow you to correct them before 
compiling. If you do not run fault finder, 
you risk FSX not properly loading the 
airport due to a compiler error. 

 

 

 

 

 

 

Figure 24 - ADE Fault Finder 

After running Fault Finder and correcting any design faults, select Compile Airport 
under the File Menu. This command will compile your work into a .bgl file that you 
can then place into your Microsoft Flight Simulator X / Addon Scenery / scenery 
folder. The next time you load FSX, the program will index your new file so that when 
you go to the airport in free flight, you will see the changes you just made. Be careful 
not to compile airport changes while FSX is running. Doing so may result in an error 
message and the loss of your modifications.  Therefore, you should make it a practice 
to Save Airport often and Compile Airport only when not running FSX. 
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Adding & Modifying Airport Aprons 
An airport apron is like a canvas on which an artist paints his or her picture. In your 
case, you used the existing FBO apron to add links and parking ramps to make the 
airport look and function more like the real airport.  However, to complete the next 
series of modifications to KMGY, you will need to create and position additional 
airport aprons. 

Remember that useless taxi path to the right of the FBO Apron? You are now going to 
turn that into a parking lot for airplanes, just like at the real airport. 

Before we begin, take another look at the Virtual Earth image of KMGY in bird’s eye 
view.  You will notice that the taxi path used for parking is about half the width of the 
main taxi path.  Now switch over to the ADE view of KMGY.  The width is the same 
as the main taxi path (24.38 meters). Also notice that the parking taxi path is about 
three widths away from the main taxi path in the VE image, whereas it about one 
width away in ADE. 

 
Figure 25 - ADE and Virtual Earth Views of the Parking Taxi Path 

To adjust both the width and spacing of the parking taxi path, first create a guideline 
that is 87.2 meters (286.09 feet) long, with a heading of 273.9 degrees. Next, position 
the end of the guideline on the center of the blue normal taxi node that connects the 
main taxi path to the parking taxi path. 
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Now, move the parking taxi path to 
the right until the connecting blue 
normal taxi node is even with and 
centered on the right end of the 
guideline. 

 

 

Next, reposition your guideline 
between the FBO apron and apron 
below it and align the left end on the 
center on main taxi path.  You can 
now select the blue normal taxi point 
at the end of the parking taxi path 
and position it on the right end of the 
guideline. 

 

 

You have one more thing to do to the 
parking taxi path before you move on. 
Multi-Select both the connecting taxi path 
and the parking taxi path and open the 
Properties Box by pressing Enter. Change 
the width from 24.38 meters to 15 meters 
(49.21 feet), and click OK. If you have 
completed all these steps successfully, the 
parking taxi path should look like this. 

You are now ready to add your aprons. 

 

 

 

 

 

Figure 26 - Repositioned and Resized Parking Taxi Path 
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Adding aprons to your airport is straight forward using the ADE tool bar. Select the 
apron surface you want using the drop down selection box, click on the apron icon 
button, and start placing apron vertices. 

An apron needs at least three vertices, 
but can have as many as you need. 
Once you are done placing your 
vertices, place the last vertex on the first 
vertex you created to complete the 
apron, or double click on the final point 
and ADE will close the apron for you. 

 

 

While creating aprons is easy, sizing and aligning your aprons is somewhat tricky. To 
facilitate the creation of your parking aprons for KMGY, you are once again going to 
use guidelines. You will need to create three additional guidelines that will serve as the 
frame for your parking aprons: 

 Guideline 1 – heading 273.9, length 70 meters (229.66 feet) 

 Guidelines 2 & 3 – heading 183.9, length 12 meters (39.37 feet) 

Next, you should align the ends of the two smaller guidelines to the ends of the longer 
guideline. 

 

You will use the four corners of this frame to place each of your apron vertices. For 
your KMGY aprons, you will want to select asphalt as the surface type. 

 

Place the last vertex over the first one, and ADE will create your first apron. 
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To correctly position your parking aprons under the parking taxi path, take the 
guideline you used earlier to position the parking taxi path and resize it to 35 meters 
(114.83 feet).  

Next align the right end of the 
guideline on the center of the 
parking taxi way, a little below the 
connecting taxi path. 

 

 

 

Now, move the parking apron you 
just created by clicking in the center 
of the apron, and with your left 
mouse button depressed, drag the 
apron over to align it with the 
guideline. 

 

Create one more guideline -- this 
time with a heading of 183.9 
degrees and a length of 15 meters 
(49.21 feet).  Align the end of this 
second guideline to the bottom 
edge of the apron you just 
positioned, and move the first 
guideline down, keeping it aligned 
with the center of the taxi path. 

 

Next, create another asphalt apron 
using the guideline framework, and 
align it to the two guidelines. Once 
the second apron is positioned 
correctly, move the two guidelines 
and repeat the process until you 
have created and properly 
positioned seven parking aprons. 
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If you have completed the above steps successfully, the parking taxi path and aprons 
should look like the picture below: 

 Now it is time to add parking ramps to these aprons so that your AI aircraft will park 
like the aircraft appear in the Virtual Earth bird’s eye view. 

 

 

 

 

Figure 27 - Completed Parking Taxi Path with Aprons 

Next, you will need to create 14 small GA ramps with a radius of 5 meters (or 16.40 
feet): 7 with a heading of 273.9, and 7 with a heading of 93.9. Remember to use the 
multi-select function to save yourself some time. 

Now, reposition the original long vertical guideline, 
which you created at the beginning of this tutorial, a 
few meters within the outer edge of the parking 
aprons you just created and align your first parking 
ramp using that guideline. 

For the parking aprons on the west side, you will use 
the parking ramps with the heading of 93.9 degrees. 
Be sure to center each ramp on the parking apron. 
Once you have placed and aligned all the west side 
parking ramps, reposition the long vertical guideline 
and repeat the process on the east side using the 
ramps with the 273.9 degree headings. 
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To help in the alignment process, you can use the 70 meter guideline you created 
earlier to build the parking aprons.  

Position it at the center of your 
West parking ramps, and align the 
East parking ramps with both the 
vertical guideline and this guideline. 

 

 

 
If you have done the preceding steps correctly, your modified parking taxi path will 
look like this: 

The final step is to connect your new parking ramps via 
parking links to the parking taxi path. Again, you can use the 
70 meter guideline you created to align the parking links for 
both the East and West parking ramps. To create parking 
links, following the steps outlined previously on pages 12 
and 13 of this tutorial. 

Once you have connected all the parking ramps to the taxi 
path, multi-select the parking links, set the width to 10 
meters, and make sure the Center Line box is checked. This 
will ensure all the parking lines are uniform when viewed in 
FSX. 

By placing the parking ramps in this fashion, AI aircraft that 
spawn at your airport will face the direction indicated by the 
parking ramp heading.  However, when an AI aircraft lands 
at your airport and parks at one of these parking ramps, it 
will face the opposite direction because the parking link is 
connected to the front of the parking ramp. 
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If you have followed along with this tutorial, your KMGY FBO area in ADE should 
resemble the picture below: 

 
Figure 28 - Completed KMGY FBO Area 

If your ADE KMGY schema looks different, review this tutorial again to find where 
you may have overlooked a step or made a mistake. If everything looks good, go ahead 
and fun the fault finder and select Save Airport from the File Menu. After ADE saves 
the airport, select Compile Airport, place the .bgl file into the FSX add-on scenery 
folder, and start FSX. 

 
Figure 29 - Final KMGY FBO Apron Area in FSX 

Congratulations on completing Tutorial 2: Basic Airport Design – Paths, Parking, and 
Aprons. You have just expanded the parking at KMGY from eleven parking ramps to 
over 30 ramps. 


